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OVERVIEW 
This document applies to the TANDBERG FieldView mobile video collaboration system.  The document 
provides product release notes for the FieldView Application, including a description of new features, 
resolved issues and a list of known issues. 

FieldView provides mobile real-time video conferencing for locations that are usually not accessible with 
standard video conferencing equipment.  This includes locations such as test labs, health care facilities, 
factory floors, service departments, remote suppliers, inspection areas, customer facilities, and other 
remote work team locations. 

Software Installation 
The FA software is meant to be installed on a PC with these minimum requirements: 
 
Operating System: Microsoft Windows XP, Windows Vista or Windows 2000 
Processor speed: 1 GHz (1.5 GHz recommended) 
Disk space: Up to 120 MB required (if Microsoft DirectX and Microsoft .NET Framework 

components are not already installed) 
Network: A wired 10/100 Ethernet port is recommended.  Some wireless network 

adapters may not be optimized for voice and video operation 
Video card: DirectX v9.0c compatible video graphics card 
Audio support: For voice and audio support, the host computer must have a microphone and 

speakers and/or headset and/or USB speakerphone 
  
To install the software: 
 

1. If you have previously installed the FA software and it is currently running you should first exit it. 
Look for the FA icon in the Windows Task Tray notification area then right-click and select Exit. 
 
Note: On Vista machines running a pre-3.x.x version of the FA, the existing version 
should be manually uninstalled before proceeding with the installation.  
 

2. Insert the CD into the computer. The installation process should start on its own. If it does not:  
a. Click the Start button on your Windows desktop, and select Run... to open the Run 

dialog. 
b. Type D:\FA\setup.exe and click OK to start the installation (use a drive letter that 

matches your CD drive). 
3. Follow the installation prompts. The installation puts an icon on your desktop and an option into 

your Start menu. 
 
Depending on what has already been installed on your computer, first-time setup may prompt you to 
install a number of utilities, such as the Microsoft .NET Framework and Microsoft DirectX. Simply follow 
the prompts as they appear, and re-boot the machine as required. 

References  
TANDBERG Web Site  http://www.tandberg.com

TANDBERG FTP Site  http://ftp.tandberg.com

For all documentation, please see the TANDBERG Support Website at 
http://www.tandberg.net/support/documentation.php. 
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SOFTWARE RELEASE NOTES FOR TANDBERG 
FIELDVIEW APPLICATION VERSION 3.4.10 

Introduction 
These release notes describe the new features and capabilities included in the TANDBERG FieldView 
Application software version 3.4.10. 

Note: The FieldView Application software Version 3.4.10 works in conjunction with FieldView Device 
software Version 3.98.30. Reference the FieldView Device Software Release Notes regarding the latest 
version of the device software. 

New Product 

FieldView Rugged  

TANDBERG FieldView™ Rugged takes all the exciting collaboration capabilities of FieldView and adds 
new features to make it the most rugged mobile video solution available.  

 

 
                               Figure 1 
 

 

 

 

 Drop proof up to 1.22 meter (4 feet) 
on concrete 

 Environmental Sealing IP54 

 Operating Temp of -10°C to +40°C 
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New Features 

Usability 

Enhanced Call Recording 

In addition to the audio stream associated with an active video stream, FieldView records full-duplex 
voice audio.  Calls can be recorded without an active video stream.  This provides a complete record of 
a call, including two-way voice, video, subject audio, images and telestration. 

Security 

Configuration Access Control 

Access rights for configuration items can be determined by the FieldView administrator.  The default 
access rights may be modified to permit changes to configuration items by all users or only by 
administrators.  Modifying the access rights requires FieldView Management Suite version 1.3 or 
higher. 

Privacy (Recording) Control 

Recording can be disabled for privacy or security reasons.  When recording is disabled, video, audio 
and images can not be stored either internally or to removable media.  When used with a FieldView 
Device running software version 3.98.30 or higher, if recording is disabled by any call participant then 
recording is disabled for all participants. 

If recording is enabled, an onscreen indicator is provided to inform the local user that the remote 
endpoint is actively recording content. 

Privacy may be enabled by selecting “Enable Privacy” on the File->Preferences->Security 
configuration window. 

Network 

Enhanced Bandwidth Control 

Maximum video bandwidth can be specified using the bandwidth control available at File-
>Preferences->Call Window.  Video profiles or custom configurations that exceed the specified 
bandwidth will be disabled. 

When bandwidth control is enabled, FieldView limits video bandwidth to the maximum value negotiated 
during call setup with the remote SIP endpoint. 

User Interface 

New/Modified Icons 

Icon Description 

 

Recording disabled (Privacy mode)  

                                                                           Figure 2 
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Software Updates 

Annual maintenance license keys have been removed in order to improve the software update process.  
Release keys are now entered during installation of a software update.  The key used for reinstallation 
does not expire on an anniversary date and may be used to reinstall the software update as many times 
as necessary (on the same licensed platform).  Release keys for FieldView products covered by service 
and maintenance contracts may be obtained through TANDBERG WebRK. 

Changes and Improvements since Previous Version 

Video 

 Fixed issue that caused the application to crash when sharing certain malformed images.  Ref 
#3050. 

Usability  

 Fixed issue that allowed SIP URI’s to be entered with an embedded space.  Ref #2984. 

 Fixed issue that caused the image viewer scroll bars to disappear when viewing a large image 
and selecting ‘Fit to Window’.  Ref #3120. 

 Improved error checking for SIP server addresses.  Ref #3224. 

 Add Image Annotator to the Windows ‘Open With…’ right-click context menu for JPEG files.  
Ref #3245. 

 Fixed issue that under some circumstances could result in the application aborting with an 
exception when running on Windows Vista.  Ref #3326. 

 Added a microphone mute control accessible from the Volume Call Controls in the Call Window.  
Ref #2042. 

 Fixed issue that displayed the audio source as ‘Unknown’ when an external microphone is 
selected.  Ref #3389. 

 Improved clarity of various status messages based on customer feedback.  Ref #3054, #3316, 
#1393, #3183 

Security 

 Fixed a problem that caused the application to crash when operating on Windows computers 
that have the “Use FIPS compliant algorithms for encryption” option set.  Note: The FieldView 
Application is not currently FIPS-certified.  Ref #3399. 

Install Issues 

 Fixed issue that prevented the installer from updating necessary DirectX components if the 
application was executing during the install.  The DirectX installer would sometimes fail without 
warning the user.  Ref #3265. 

Supported Platforms 

 FieldView Application may be installed on Vista 64-bit platforms.  Ensure your Vista drivers are 
up-to-date.  Ref #3192. 
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Known Limitations 

Equipment Limitations 

TANDBERG FieldView 
Application  

Version 3.4.10  
(Norton Antivirus) 

Computers with Norton Antivirus may report a security alert for the first time 
the application receives an incoming call. To correct this select “Permit” to 
allow the communication to proceed.  

TANDBERG FieldView 
Application  

Version 3.4.10 
(Firewalls) 

Firewalls may block connections. To correct this make an exception for 
“Mobile Collaboration Application”.  

TANDBERG FieldView 
Application  

Version 3.4.10 
(Cisco VPN Client) 

Cisco VPN Client firewall may block connections even through Windows 
Network Connections show as disabled. To correct this disable the “Stateful 
Firewall (Always ON)” with the Cisco VPN Client.  

TANDBERG FieldView 
Application  

Version 3.4.10 
(Graphic Cards & Drivers) 

With some combinations of graphic cards and drivers the application may not 
operate correctly when the computer is configured for multiple displays. 
Update the video drivers to the latest version and if this does not correct the 
issue then operate the application on the primary display or do not operate the 
host PC with multiple displays during a call.  

TANDBERG FieldView 
Application  

Version 3.4.10 
(Video) 

Video recorded from a FieldView Device with software Version 2.40 could 
result in choppy video when played back, even when the live video appears 
smooth. Recommend: Upgrade the FieldView Device to the latest software 
version.  Ref #1836. 

TANDBERG FieldView 
Application  

Version 3.4.10 
(Video) 

The video aspect ratio is incorrect for CIF images.  Ref #1628, #2722. 

TANDBERG FieldView 
Application  

Version 3.4.10 
(Audio Source) 

The application does not provide a method to remotely select subject audio 
source (i.e. built in microphone or external audio line-in). The audio source can 
be configured on the FieldView Device under Configuration > Audio. 

TANDBERG FieldView 
Application  

Version 3.4.10 
(Time Zones / Daylight 

Savings) 

If the time zone or daylight saving time changes while the application is 
running, the time reported in the application will be incorrect. Close and restart 
the application after the change.  

TANDBERG FieldView 
Application  

Version 3.4.10 
(Installation) 

If the application is launched while a Windows command window is in the 
foreground, it may result in the login screen being hidden behind this window. 
Click on the task tray icon or move\minimize the command window to display 
login screen.   

TANDBERG FieldView 
Application  

Version 3.4.10 
(Installation) 

If a new version of software is installed while the existing version is running, 
the user will receive a prompt before the running version is closed 
automatically by the installer. If the user manually closes the running version 
while the prompt is on the screen it will cause the install to fail. Either close the 
running version prior to running the installer or let the installer automatically 
close the running version. 

TANDBERG FieldView 
Application  

Version 3.4.10 
(Pause) 

Pressing “pause” on the application while the FieldView Device is streaming 
from the external S-Video source will not pause the video. Pause has no effect 
in this mode.  

TANDBERG FieldView 
Application  

Version 3.4.10 
(Auto-Login) 

The Auto-Login configuration settings are lost when upgrading from pre-3.x.xx 
software. Recommend: Re-enter auto-login configuration setting after 
upgrading to 3.x.xx software.  Ref #2128. 

TANDBERG FieldView 
Application  

Installation may fail on Microsoft Windows 2000 platform, which does not have 
DirectX 9 already installed. During the installation the DirectX installer may 
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Version 3.4.10 
(Microsoft Windows 2000) 

display an error before rebooting. Recommend: After the computer is 
rebooted, re-install the software. The second attempt should install 
successfully.   Ref #2160. 

TANDBERG FieldView 
Application  
 (Security) 

If “Use FIPS compliant algorithms for encryption” is enabled, FieldView 
Application requires that .NET Framework 2.0 SP1 be installed. Otherwise, the 
program cannot be installed or run. 
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SOFTWARE RELEASE NOTES FOR TANDBERG 
FIELDVIEW APPLICATION VERSION 3.3.7 

Introduction 
These release notes describe the new features and capabilities included in the TANDBERG FieldView 
Application software version 3.3.7. 

Note: The FieldView Application software Version 3.3.7 works in conjunction with FieldView Device 
software Version 3.98. Reference the FieldView Device Software Release Notes regarding the latest 
version of the device software. 

New Product 

FieldView Ex  

TANDBERG FieldView™ Ex takes all the exciting collaboration capabilities of FieldView and adds new 
features to make it the most rugged mobile video solution available. Ex certified products are designed 
for use in the most demanding environments, where safety and wear-and-tear on communication 
equipment are of prime concern. 

 

 
                               Figure 3 
 

 

 

 

 Ex Certification 

 Explosion Protected 

 Drop proof up to 1.22 meter (4 feet) 
on concrete 

 Environmental Sealing IP54 

 Operating Temp of -10°C to +40°C 
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New Features 

Video 

Image Sharing Mode (ISM) 

ISM disables video streaming and selects the lowest bit-rate voice codec to minimize bandwidth usage.  
Typically, this mode could be used when network bandwidth is insufficient to support reliable operation 
with video streaming (e.g. when operated over a Wireless Wide Area Network (WWAN) or a low speed 
link).  ISM can be selected on high bandwidth networks as well to limit the amount of bandwidth that will 
be used.  When ISM is selected, a call can be established in the normal manner and images can be 
shared; however, video streaming is not permitted.  Once entered, ISM cannot be exited to return to 
Video Mode without disconnecting the call.  Select ISM from Connections->Mode or from the Mode 
selector in the FA status bar. 

 

 
                                                                         Figure 4 
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Image Preview 

The Image Viewer now supports the ability to preview an image.  Select the image thumbnail and right-
click the mouse.  Select Preview from the pop-up menu.  The image can also be previewed by double-
clicking the thumbnail.  Previewing an image does not affect the current shared image 

 

 
                                                                   Figure 5 

Telestration Colors 

Telestration colors can be edited.  Color preferences can be configured from the Telestration tab 
accessible via File->Preferences...  Telestration colors can also be configured during a call using the 
FD Controls on the call window.  Color changes are also updated to the same values on the remote 
device. 

 
Figure 4 
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Changes and Improvements since Previous Version 

Video 

 Corrected a possible issue where larger images would push the preview window frame and 
controls beyond the monitor. 

 Corrected the possible issue of the video bit rate being incorrectly reported. 

Audio 

 Corrected possible issues caused by invalid audio configuration setting. 

 Corrected a possible issue which sometimes caused the busy signal not to be heard. 

Network 

 Improved the reporting of SIP registration states. 

Usability 

 Added the ability to add contacts using only an IP address. 

 Remote zoom/focus/illumination controls are now available with or without a active stream 
present. 

 Improvements made to launch time of the image viewer. 

 Resolved possible issue which caused the “Open Recordings” command to be disabled until 
the application was restarted. 

 Resolved possible issue which sometimes caused error messages to be hidden behind splash 
screen. 

 The demo period has been increased from 30 to 60 days. This allows 60 days of unrestricted 
operation of FA the first time it is installed on a PC. 

Known Limitations 

Equipment Limitations 

TANDBERG FieldView 
Application  

Version 3.3.7  
(Norton Antivirus) 

Computers with Norton Antivirus may report a security alert for the first time 
the application receives an incoming call. To correct this select “Permit” to 
allow the communication to proceed.  

TANDBERG FieldView 
Application  

Version 3.3.7  
(Firewalls) 

Firewalls may block connections. To correct this make an exception for 
“Mobile Collaboration Application”.  

TANDBERG FieldView 
Application  

Version 3.3.7  
(Cisco VPN Client) 

Cisco VPN Client firewall may block connections even through Windows 
Network Connections show as disabled. To correct this disable the “Stateful 
Firewall (Always ON)” with the Cisco VPN Client.  

TANDBERG FieldView 
Application  

Version 3.3.7  
(Graphic Cards & Drivers) 

With some combinations of graphic cards and drivers the application may not 
operate correctly when the computer is configured for multiple displays. 
Update the video drivers to the latest version and if this does not correct the 
issue then operate the application on the primary display or do not operate the 
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host PC with multiple displays during a call.  
TANDBERG FieldView 

Application  
Version 3.3.7 

(Video) 

Video recorded from a FieldView Device with software Version 2.40 could 
result in choppy video when played back, even when the live video appears 
smooth. Recommend: Upgrade the FieldView Device to the latest software 
version. 

TANDBERG FieldView 
Application  

Version 3.3.7 
(Video) 

The video aspect ratio is incorrect for CIF images.  

TANDBERG FieldView 
Application  

Version 3.3.7  
(Audio Source) 

The application does not provide a method to remotely select subject audio 
source (i.e. built in microphone or external audio line-in). The audio source can 
be configured on the FieldView Device under Configuration > Audio. 

TANDBERG FieldView 
Application  

Version 3.3.7  
(Time Zones / Daylight 

Savings) 

If the time zone or daylight saving time changes while the application is 
running, the time reported in the application will be incorrect. Close and restart 
the application after the change.  

TANDBERG FieldView 
Application  

Version 3.3.7  
(Installation) 

If the application is launched while a Windows command window is in the 
foreground may result in the login screen being hidden behind this window. 
Click on the task tray icon or move\minimizing the command window to display 
login screen.   

TANDBERG FieldView 
Application  

Version 3.3.7  
(Installation) 

If a new version of software is installed while the existing version is running, 
the user will receive a prompt before the running version is closed 
automatically by the installer. If the user manually closes the running version 
while the prompt is on the screen will cause the install to fail. Either close the 
running version prior or let the installer automatically close the running version.

TANDBERG FieldView 
Application  

Version 3.3.7  
(Pause) 

Pressing “pause” on the application while the FieldView Device is streaming 
from the external S-Video source will not pause the video. Pause has no effect 
in this mode.  

TANDBERG FieldView 
Application  

Version 3.3.7 
(Auto-Login) 

The Auto-Login configuration settings are lost when upgrading from pre-3.x.xx 
software. Recommend: Re-enter auto-login configuration setting after 
upgrading to 3.x.xx software. 

TANDBERG FieldView 
Application  

Version 3.3.7 
(Microsoft Windows 2000) 

Installation may fail on Microsoft Windows 2000 a platform, which does not 
have DirectX 9 already installed. During the installation the DirectX installer 
may display an error before rebooting. Recommend: After the computer is 
rebooted, re-install the software. The second attempt should install 
successfully.  
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SOFTWARE RELEASE NOTES FOR TANDBERG 
FIELDVIEW APPLICATION VERSION 3.1.12 

Introduction 
These release notes describe the new features and capabilities included in the TANDBERG FieldView 
Application software version 3.1.12. 

Note: The FieldView Application software Ver 3.1.12 works in conjunction with FieldView Device 
software Ver 3.76. Reference the FieldView Device Software Release Notes regarding the latest 
version of the device software. 

New Features 

Enterprise Suite License Manager 

Software ver 3.1.12 now includes support for the FieldView Enterprise license manager.  Selection has 
been added under the Tools menu to configure a connection with a license server and report license 
information.  The current license status is highlighted on the main FA window. 

 

 

 
Figure 1: License 
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Security 

Added Support for SRTP/AES encryption of video and audio streams, and data channel for security. 

 
Figure 2: Media Encryption Mode 
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Changes and Improvements since Previous Version 

Video 

Improved video quality when suffering packet loss - The video drawing algorithm has been modified to 
prevent tiling effects caused by frame corruption during periods of packet loss. 

Audio 

Removing the active audio now causes the default audio device to be used 

It is now possible to run the application on a computer that does not have an audio device. 

Resolved an issue with that prevented acoustic echo canceller from operating correctly on the Vista 
platform. 

Network 

Corrected an issue where IP dialing was not permitted when device is not registered to a SIP registrar. 

Resolved an issue where SIP registration status was displayed incorrectly. 

Corrected an issue where an image capture from the FD resulted in an error message. 

Usability  

Corrected an issue where installation was sometimes incomplete. 

Add a message window to warn users when deleting folders in the image viewer that contains non-
image files. 

Various performance and stability improvements 
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Known Limitations 

Equipment Limitations 

TANDBERG FieldView 
Application  
Ver 3.1.12  

(Norton Antivirus) 

Computers with Norton Antivirus may report a security alert for the first time 
the application receives an incoming call. To correct this select “Permit” to 
allow the communication to proceed.  

TANDBERG FieldView 
Application  
Ver 3.1.12  
(Firewalls) 

Firewalls may block connections. To correct this make an exception for 
“Mobile Collaboration Application”.  

TANDBERG FieldView 
Application  
Ver 3.1.12  

(Cisco VPN Client) 

Cisco VPN Client firewall may block connections even through Windows 
Network Connections show as disabled. To correct this disable the “Stateful 
Firewall (Always ON)” with the Cisco VPN Client.  

TANDBERG FieldView 
Application  
Ver 3.1.12  

(Graphic Cards & Drivers) 

With some combinations of graphic cards and drivers the application may not 
operate correctly when the computer is configured for multiple displays. 
Update the video drivers to the latest version and if this does not correct the 
issue then operate the application on the primary display or do not operate the 
host PC with multiple displays during a call.  

TANDBERG FieldView 
Application  
Ver 3.1.12 

(Video) 

Video recorded from a FieldView Device with software Ver. 2.40 could result in 
choppy video when played back, even when the live video appears smooth. 
Recommend: Upgrade the FieldView Device to the latest software version.  

TANDBERG FieldView 
Application  
Ver 3.1.12  

(Audio Source) 

The application does not provide a method to remotely select subject audio 
source (i.e. built in microphone or external audio line-in). The audio source can 
be configured on the FieldView Device under > Configuration > Audio. 

TANDBERG FieldView 
Application  
Ver 3.1.12  

(Time Zones / Daylight 
Savings) 

If the time zone or daylight saving time changes while the application is 
running, the time reported in the application will be incorrect. Close and restart 
the application after the change.  

TANDBERG FieldView 
Application  
Ver 3.1.12  

(Installation) 

If the application is launched while a Windows command window is in the 
foreground may result in the login screen being hidden behind this window. 
Click on the task tray icon or move\minimizing the command window to display 
login screen.   

TANDBERG FieldView 
Application  
Ver 3.1.12  
(Pause) 

Pressing “pause” on the application while the FieldView Device is streaming 
from the external S-Video source will not pause the video. Pause has no effect 
in this mode.  

TANDBERG FieldView 
Application  
Ver 3.1.12 

(Auto-Login) 

The Auto-Login configuration settings are lost when upgrading from pre-3.x.xx 
software. Recommend: Re-enter auto-login configuration setting after 
upgrading to 3.x.xx software. 

TANDBERG FieldView 
Application  
Ver 3.1.12 

(Microsoft Windows 2000) 

Installation may fail on Microsoft Windows 2000 a platform, which does not 
have DirectX 9 already installed. During the installation the DirectX installer 
may display an error before rebooting. Recommend: After the computer is 
rebooted, re-install the software. The second attempt should install 
successfully.  
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SOFTWARE RELEASE NOTES FOR TANDBERG 
FIELDVIEW APPLICATION VERSION 3.0.13 

Introduction 
These release notes describe the new features and capabilities included in the TANDBERG FieldView 
applications software version 3.0.13. 

Note: The FieldView Application software Ver 3.0.13 works in conjunction with FieldView Device 
software Ver 3.34. Reference the FieldView Device Software Release Notes regarding the latest 
version of the device software. 

New Features 

TANDBERG Video Communication Server (VCS) 

Software Ver 3.0.13 is now compatible with the TANDBERG Video Communication Server (VCS) in SIP 
registration. 

Note: Requires Ver X2.0 on TANDBERG Video Communication Server (VCS)  

Note: This functionality is SIP registration only.  When registering to the VCS Expressway, firewall 
traversal will not be guaranteed as the FieldView Application does not support traversal technology. 

Video 

Support for bidirectional image capture and sharing by adding a remote snapshot button which will 
capture an image from the FieldView device and be displayed in the Image Viewer of the FieldView 
application. The image detail quality has been improved over the original snapshot which capture 
MPEG4 compressed stream. The images are saved on the PC’s hard drive as a jpeg file and can be 
viewed and managed with the image viewer. The Images can also be selected during a call with the 
FieldView device to telestrate while viewing the shared images.  

 
Figure 6: Snapshot Buttons 

 
Figure 7: Snapshots 
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Recording format has been enhanced to include complete session information namely video, subject 
audio, still images, telestration, and timeline. When you play back the recording it reconstructs what 
occurred during the session, including popup images, drawing telestration, etc.  

The ability to stream a video recording from the FieldView Application to the FieldView Device during a 
call has been added. User can simultaneously telestrate and speak while the recording is being viewed 
and allows the displaying of image to the remote user.  

 
Figure 8: Recording Streams 

 

Added support for FieldView recordings (.lmc) to be played in QuickTime (.mov). QuickTime Ver 7 is 
required for this feature.  

Note: Telestration and other session data not supported in QuickTime 
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Audio 

Added a new low-bit rate voice codec (GSM 6.10), which operates at 13kbps. This minimizes the audio 
bandwidth utilization on low bandwidth connections compared with the original G.711 codec that 
operates at 64kbps. This can be specified for low-bit rate codec by selecting the Optimize voice and 
subject audio check boxes.   

 
Figure 9: Preferences (Audio) 

Note: If calling a FieldView Device with software 2.x then G.711 audio will be used.  

Usability 

Improved the network monitoring and reporting during a call with stream status, which provides 
information about the prevailing network conditions. This is available under File > Stream link status. If 
degraded network conditions are detected, this will be indicated in RED in the video stream rate.  

 
Figure 10: Stream Link Status 

 
Figure 11: Network Conditions 

 

FieldView Application 3.0.13 is compatible on Windows Vista.  
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Changes and Improvements since Previous Version  

Usability  

Corrected the Multi-Monitor issue when onscreen annotations are used.  

Corrected the renaming issue for directories and file for still images. 

Corrected the scroll and zoom when at a high zoom levels. 

Corrected the misaligned telestration issues at high zoom levels. 

Corrected the audio volume control. 

Corrected minor installations issues. 

General stability corrections that could have resulted in abnormal termination.  

Improved error handling for corrupt Contact files. 

Improved the receiving an incoming call while in play back mode.      
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Known Limitations 

Equipment Limitations 

TANDBERG FieldView 
Application  
Ver 3.0.13  

(Norton Antivirus) 

Computers with Norton Antivirus may report a security alert for the first time 
the application receives an incoming call. To correct this select permit to allow 
the communication to proceed.  

TANDBERG FieldView 
Application  
Ver 3.0.13  
(Firewalls) 

Firewalls may block connections. To correct this make an exception for 
“Mobile Collaboration Application”.  

TANDBERG FieldView 
Application  
Ver 3.0.13  

(Cisco VPN Client) 

Cisco VPN Client firewall may block connections even through Windows 
Network Connections show as disabled. To correct this disabled the “Stateful 
Firewall (Always ON)” with the Cisco VPN Client.  

TANDBERG FieldView 
Application  
Ver 3.0.13  

(Graphic Cards & Drivers) 

With some combinations of graphic cards and drivers may result in the 
applications not operating correctly when the computer is configured for 
multiple displays. Update the video drivers to the latest version and if this does 
not correct the issue then operate the application on the primary display or do 
not operate the host PC with multiple displays during a call.  

TANDBERG FieldView 
Application  
Ver 3.0.13 

(Video) 

Video recorded from a FieldView Device with software Ver. 2.40 could result in 
choppy video when played back, even when the live video appears smooth. 
Recommend: Upgrade the FieldView Device to the latest software version.  

TANDBERG FieldView 
Application  
Ver 3.0.13  

(Audio Source) 

The application does not provide a method to remotely select audio source 
(i.e. built in microphone or external audio line-in). The audio source can be 
configured on the FieldView Device under > Configuration > Audio. 

TANDBERG FieldView 
Application  
Ver 3.0.13 

(Audio & Windows Vista) 

Currently the echo cancellation does not work as expected with Windows 
Vista. This could cause significant echo to be heard on the far-end, particularly 
if the volume setting on the Vista PC is high. Recommend: Reducing the 
volume, use a headset or external USB speakerphone.  

TANDBERG FieldView 
Application  
Ver 3.0.13  

(Time Zones / Daylight 
Savings) 

If the time zone or daylight saving time changes while the applications is 
running, the time reported in the application will be incorrect. Close and restart 
the applications after the change.  

TANDBERG FieldView 
Application  
Ver 3.0.13  

(Installation) 

If the applications is launched while a Windows command window is in the 
foreground may result in the login screen being hidden behind this window. 
Click on the task tray icon or move\minimizing the command window to display 
login screen.   

TANDBERG FieldView 
Application  
Ver 3.0.13  
(Pause) 

Pressing “pause” on the application while the FieldView Device is streaming 
from the external S-Video source will not pause the video. Pause has not 
effect in this mode.  

TANDBERG FieldView 
Application  
Ver 3.0.13 

(Auto-Login) 

The Auto-Login configuration settings are lost when upgrading from pre-3.x.xx 
software. Recommend: Re-enter auto-login configuration setting after 
upgrading to 3.x.xx software. 

TANDBERG FieldView 
Application  
Ver 3.0.13 

(PEAP \ EAP TLS 
Authentication) 

Currently there is no notification if an incorrect password or invalid certificate 
for PEAP or EAP – TLS authentication is used, other then not connecting to 
the network. Recommend: Re-install the certificate and/or re-enter the 
authentication password.  
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TANDBERG FieldView 

Application  
Ver 3.0.13 

(Image Viewer) 

The Image Viewer permits a user to delete a non-empty folder. The Image 
Viewer does not display non-images files, so it’s possible that the user will 
inadvertently delete a directory that contains other files. Recommend: Do not 
use the Image Viewer to delete a directories that may contain video or other 
files. Before deleting, verify the directory is empty using Windows File 
Explorer.  

TANDBERG FieldView 
Application  
Ver 3.0.13 

(Microsoft Windows 2000) 

Installation may fail on Microsoft Windows 2000 a platform, which does not 
have DirectX 9 already installed. During the installation the DirectX installer 
may display an error before rebooting. Recommend: After the computer is 
rebooted, re-install the software. The second attempt should install 
successfully.  

 

 Page 25 of 25 

 


	DOCUMENT REVISION HISTORY
	OVERVIEW
	Software Installation
	References 

	SOFTWARE RELEASE NOTES FOR TANDBERG FIELDVIEW APPLICATION VERSION 3.4.10
	Introduction
	New Product
	FieldView Rugged 

	 New Features
	Usability
	Enhanced Call Recording

	Security
	Configuration Access Control
	Privacy (Recording) Control

	Network
	Enhanced Bandwidth Control

	User Interface
	New/Modified Icons

	Software Updates

	Changes and Improvements since Previous Version
	Video
	Usability 
	Security
	Install Issues
	Supported Platforms
	Known Limitations


	SOFTWARE RELEASE NOTES FOR TANDBERG FIELDVIEW APPLICATION VERSION 3.3.7
	Introduction
	New Product
	FieldView Ex 

	New Features
	Video
	Image Sharing Mode (ISM)
	Image Preview
	Telestration Colors


	Changes and Improvements since Previous Version
	Video
	Audio
	Network
	Usability
	Known Limitations


	SOFTWARE RELEASE NOTES FOR TANDBERG FIELDVIEW APPLICATION VERSION 3.1.12
	Introduction
	New Features
	Enterprise Suite License Manager
	 Security

	 Changes and Improvements since Previous Version
	Video
	Audio
	Network
	Usability 
	 Known Limitations


	SOFTWARE RELEASE NOTES FOR TANDBERG FIELDVIEW APPLICATION VERSION 3.0.13
	Introduction
	New Features
	TANDBERG Video Communication Server (VCS)
	Video
	 Audio
	Usability

	 Changes and Improvements since Previous Version 
	Usability 
	 Known Limitations



